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 Product Information 

1.1. Product Description  

Animaltype Sheep is a set of reagents for molecular genetic characterization 
of domestic sheep for the analysis of kinship and DNA individualization of 
animals based on multiplex PCR analysis of 12 loci containing short tandem 
repeats (STR), also known as microsatellite loci, and the Amelogenin gene 
as a sex marker. The 13 analyzed loci comprise the standard marker panel 
recommended by the International Society for Animal Genetics (ISAG): 
McM042, INRA006, McM527, ETH152, CSRD247, OarFCB20, INRA172, 
INRA063, MAF065, MAF214, INRA005, INRA023 and AMEL. With 
restriction to the loci CSRD247, INRA005, INRA006, INRA023, INRA063, 
MAF065, McM527 and OarFCB20 this kit can be used for genotyping of Goat 
samples. PCR primers have been designed for the multiplex amplification of 
all 13 loci in one tube. The size of all amplifiable PCR products is <320 bp 
(taking into account all known alleles). Analysis of PCR results is carried out 
by capillary electrophoresis method using automatic genetic analyzers with 
laser-induced fluorescence detection. Animaltype Sheep uses 5 fluorescent 
dyes characterized by different emission wavelengths to enable 
simultaneous detection in different fluorescence channels. The primers are 
labeled with four fluorescent dyes that are detected in the Blue, Green, 
Yellow and Red channels. The S550 size standard is labeled with a fifth 
fluorescent dye and is detected in a separate Orange channel 
simultaneously with PCR products. To obtain a complete STR profile of the 
sample, 10 nanograms of non-degradation DNA are sufficient. The optimal 
amount is from 10 nanograms and higher. The reaction mixture in the kit is 
aliquoted in reaction stripped tubes of 0.2 ml and delivered in lyophilized 
form, due to which reaction mixtures can be stored at room temperature for 
at least 18 months without sensitivity loss. The reaction components are 
activated by adding a certain amount of activator solution to each test tube. 
Total reaction volume is 25 µl. The maximum volume of DNA solution 
introduced into the reaction can be 20 µl. 

The kit is validated for GeneAmp® 9700, GeneAmp® 2720. PCR products 
can be analyzed using ABI PRISM® 310/3100/3100Avant/3130/ 
3130XL/3500/3500XL (Applied Biosystems, Foster City, CA-US) and 
Nanofor® 05M (Syntol, Moscow, RU) genetic analyzers. 
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Locus Repeating Unit Structure 
McM042 (AC)n 

INRA006* (CA)n 

McM527* (TG)n 

ETH152 (AC)n 

CSRD247* (CA)n 

OarFCB20* (TG)n 

INRA172 (TG)n 

INRA063* (AC)n 

MAF065* (CA)n 

MAF214 (GT)n 

INRA005* (GT)n 

INRA023* (AC)n 

Table 1: Description of microsatellite markers Animaltype Sheep. The loci 
marked with the * are suitable for genotyping goat samples. 

 

1.2. Ordering information for Animaltype Sheep kit and 
its components 

The Animaltype Sheep kit is available in 8-piece vials, which are stripped 
together with separately attached lids.  

Strips 8 x 0.2 ml, vials with separately attached caps  

Name Reactions in the kit Catalog number 
Animaltype Sheep 12 x 8 tubes (96 reactions) 11-14101-0096 

 

1.3. Kit Components    

Reaction Mix 96 x 0.2 ml 12 strips with 8 wells 

Activator 5X (blue lid) 500 µl 

Deionized water (white lid) 1.7 ml 

Control DNA OM-1, (lyoph., green lid) 1 tube (20 reactions) 

Control DNA OF-2, (lyoph., green lid) 1 tube (20 reactions) 

Size standard S550, (lyoph., yellow cover) 1 tube (120 applications) 
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Strips with reaction mixtures are reaction tubes of 0.2 ml, combined into 
strips of 8 pcs. and are designed for polymerase chain reaction.  The bottom 
of the tubes contains all lyophilized components of polymerase chain 
reaction including Taq polymerase, dNTP mixture, reaction buffer, primer 
mixture. Due to the fluorescent-marked primers, the lyophilized dry vitreous 
reaction mixture at the bottom of the tubes is transparent. 

The activator solution is used to dilute the lyophilized reaction mixture. It 
contains a buffer solution and magnesium ions Mg2+ as an activator for the 
polymerase chain reaction.  

Deionized water is used to dilute the components of the set and bring the 
reactions to the working volume.  

Control DNA OM-1 is a high-molecular lyophilized genomic DNA of a male 
sheep with a known genotype for all the studied loci (Table 2, Fig. 2).   

Control DNA OF-2 is the high-molecular lyophilized genomic DNA of a 
female sheep with a known genotype across all the investigated loci (Table 
2, Fig. 3). The control DNA is designed to control the stages of amplification, 
electrophoresis and data analysis. It is supplied in lyophilized form. It 
requires dilution with water before use (item 2.1).  

Size standard S550 is a lyophilized mixture of fluorescent-labeled DNA 
fragments of different sizes, labeled with spectral analogue LIZ, detected in 
the Orange channel. The S550 size standard contains 26 DNA fragments of 
different sizes (n.a.): 60, 70, 80, 90, 100, 120, 140, 160, 180, 200, 220, 230, 
240, 260, 280, 300, 320, 340, 360, 380, 400, 420, 440, 450, 500 and 550 bp. 
Standard S550 is used at the stage of capillary electrophoresis, is introduced 
into each capillary simultaneously with the investigated sample and serves 
as a reference internal standard for building a mobility curve of the amplified 
fragments of the investigated sample. Due to high density of fragments of 
S550 standard high accuracy and reproducibility of determination of size of 
amplified fragments of the investigated sample is provided. Before use, it is 
necessary to add water (item 2.2).  

 

1.4. Storage conditions  

All components except activator solution and deionized water are supplied 
in dry condition. For this reason, no special temperature conditions are 
required during transport. Fluorescently labeled primers and size standard 
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S550 are sensitive to light and must be stored in a dark place. Users can 
store the kits at room temperature for several months without losing 
sensitivity. After dilution of lyophilized components with water they should be 
stored at 2 - 8°C for a month. For longer storage, freezing at -20°C is 
recommended. 

 

1.5. Main features of the kit  

Number of simultaneously analyzed markers - 13; List of simultaneously 
analyzed loci: McM042, INRA006, McM527, ETH152, CSRD247, 
OarFCB20, INRA172, INRA063, MAF065, MAF214, INRA005, INRA023 and 
AMEL; Number of fluorescent markers used in the kit - 5; Optimum number 
of DNA input: 10 ng, Sensitivity limit: 1 ng. 

 

Quality Assurances  

The high quality of each component of the kit is checked and controlled 
during production. Each released lot of lyophilized reagents is regularly 
checked for compliance with the declared characteristics within 18 months. 

 

1.6. Related materials  

Necessary materials that are not included in the set are supplied free 
of charge:  

Matrix standard CS5 for ABI PRISM® 3130 and ABI PRISM® 3130xl and 
Nanofor® 05. Bins and panels for GeneMapperTM.  

 

Materials supplied by other companies 

Reagent Supplier Catalogue Number 
Hi-DiTM Formamide Applied Biosystems (P/N 4311320) 

10 x Genetic Analyzer Buffer Applied Biosystems (P/N 402824) 

Polymer (POP-4) Applied Biosystems (P/N 402838) 
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  Dry Matter Dilution  

2.1. Control DNA of OM-1 and OF-2 

Add 20 µl of deionized water supplied with the kit to each test tube with dry 
control DNA (2 test tubes with green caps). Mix thoroughly on vortex and 
collectthe solution at the tubes by short centrifugation at the bottom of the 
tube. For PCR, add 1 µl of control DNA to the reaction tube. After dilution, 
control DNA should be stored at 2 - 8 °C for a month. For longer storage it is 
recommended to store in a frozen form. Repeated defrosting should be 
avoided.  

 

2.2. Size standard S550 

Before use, add 120 µl of deionized water to the S550 dry dimensional test 
tube (yellow cap tube).  Mix thoroughly on the vortex and collect the solution 
at the tube bottom by short centrifugation.  After dilution, the S550 size 
standard should be stored at 2 - 8 °C for a month. For longer storage it is 
recommended to store in a frozen form. Repeated defrosting should be 
avoided. For capillary electrophoresis, add 1 µl of S550 standard to each well 
of the plate containing the formamide and PCR product. 

 

 PCR Amplification 

3.1. Setting a reaction 

Include 5 µl Activator in each tube. Then apply up to 20 µl solution of the 
studied genomic DNA. The optimal amount of DNA to be amplified is 10 ng. 
The amount of DNA to be amplified depends on its concentration. The 
maximum possible volume of DNA solution is 20 µl. If necessary, bring the 
total reaction volume to 25 µl with deionized water supplied as part of the kit.  

Components of the reaction Volume per 1 reaction 
Activator solution 5 µl 

Genomic DNA (10 ng) up to 20 µl 

Deionized water up to the final volume 25 µl             
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For long-term storage, dilution of DNA in buffers (pH > 7) containing small 
amounts of EDTA (e.g. TE with ≤ 0.1 mM EDTA) is recommended. A high 
concentration of EDTA in DNA solution may cause a decrease in reaction 
efficiency due to magnesium ion chelation. After application of all 
components, the reaction mixture should be thoroughly stirred to 
homogeneous state 5-8 times by pipetting or using vortex. If necessary, 
collect the solution at the bottom of the tube by short centrifugation. 
Thorough stirring is necessary for maximum reaction efficiency. Two 
positive controls (1 µl of control DNA OM-1, 1 µl of control DNA OM-2 
supplied with the kit) and one negative control (deionized water instead of 
DNA) should be amplified with each series of tested samples. 

 

3.2.  Amplification conditions 

The amplification conditions listed below are recommended as standard 
parameters. 

PCR Parameters  
94°C 3 min 

95°C 10 sec 

57°C 30 sec, 35 cycles 

68°C* 60 sec 

68°C 6 min 30 sec 

20°C ∞ 
* The recommended heating rate from 57°C to 68°C is max. 1°C/1 sec. 

 

After completing the PCR program, the amplified products can be stored for 
a week at 4°C to 8°C in a light-safe place. In case the amplified PCR product 
should be stored for more than a week, freezing at -20°C is recommended. 
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 Electrophoresis on ABI PRISM 3130/3130XL Analyzer 

When working with the ABI PRISM® genetic analyzer, and subsequent 
analysis of fluorescent profiles in the GeneMapperTM program, it is necessary 
to follow the user instructions from the equipment manufacturer. For correct 
visualization of the five fluorescent Animaltype Sheep labels, it is necessary 
to perform spectral calibration for the "any5dyes" dye set using the CS5 
matrix standard.  

 

4.1. Matrix creation/spectral calibration 

The analysis of Animaltype Sheep amplification products on the genetic 
analyzer is only possible after calibration with the 5-colour matrix standard 
CS5 (not supplied with the kit, ordered separately by catalog number: 11-
14102-0050). The matrix standard contains a mixture of 5 fragments of 
different size marked with different fluorescent dyes. These dyes are used in 
the PCR tagging kit and the S550 size standard. To prepare a working 
solution of matrix standard CS5, add 50 µl of deionized water to a tube 
containing lyophilized CS5 (violet lid tube) and incubate at room temperature 
for 2 min. Then thoroughly mix the solution on the Vortex and collect the 
solution by short centrifugation at the bottom of the tube. The ready solution 
can be stored in a dark place at 2 °C - 8 °C for up to 2 weeks. For longer 
storage time, the solution should be frozen. Repeated defrosting should be 
avoided.  

 

Preparation of the calibration standard matrix (ABI 3130 /4 capillary) 
Hi-DiTM Formamide 40 µl 

Matrix Standard CS5 4 µl 

 

Add 10 µl of mixture to wells A01-D01 of 96-well plate. If necessary, remove 
bubbles from the bottom of the wells by centrifuging.  
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Preparation of the calibration standard matrix (ABI 3130 XL/16 capillary) 
Hi-DiTM Formamide 160 µl 

Matrix Standard CS5 16 µl 

 

Add 10 µl of mixture to wells A01 to H02 of 96-well plate. If necessary, 
remove bubbles from the bottom of the wells by centrifuging. 

 

Spectral calibration  

Step A - Create Instrument Protocol for Spectral Calibration 

Open Protocol Manager in Data Collection Software, go to the 
Instrument Protocol tab and select New to open the Protocol Editor Enter 
the following settings in the Protocol Editor (Instrument Protocol) window:  

Parameter Value 
Name for example, Spectral36_POP4_CS5 

Type SPECTRAL 

Dye Set any5dye 

Polymer POP4 

Array Length 36 

Chemistry Matrix Standard 

Run Module Spect36_POP4_1 

 

Select OK and close Protocol Editor 

 

Step B - Plate creation  

Go to Plate Manager of Data Collection Software to select the button 
New. The Plate Dialog window will open.  

Enter the following parameters in the New Plate dialog box: 

Name for example, Spectral_any5_CS5 

Application Spectral Calibration 

Plate Type 96-Well 

Select OK. A new Plate Editor table will appear.  
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Enter in position A01 

Sample Name  for example, CS5 

Priority for example, 100 

Instrument Protocol Spectral36_POP4_CS5 (see above) 

 

Identify cell A01 in its entirety. Select the Fill Down Special command in the 
Edit menu. The program will fill with the entered values to the corresponding 
number of cells for one capillary load. For example, from A01 to A04 (ABI 
Prism® 3130 / 4 capillaries) or from A01 to H02 (ABI Prism® 3130XL / 16 
capillaries). Select OK to complete the plate creation and exit the Plate 
Editor. 

 

Step C - Carrying out spectral calibration 

Go to the Run Scheduler - Plate View tab and select Find All. Select the 
specified name of the created plate (for example, Spectral_any5_CS5). Link 
the selected name with the plate installed in the device. Start the device. 

 

Step D - Evaluation of spectral calibration results. 

Check the status of each capillary (pass or fail) after the device is finished. 
Open Instrument Status, go to the Event Log tab. The Event Messages 
window displays the status of all capillaries. Each capillary must have a Q-
value of at least 0.95. The peak heights should be at least 1,000 rfu, but 
below 5,000 rfu (optimal range between 2000 and 4000 rfu). Additionally, 
you can view the fluorescent calibration profile for each capillary in the 
Spectral Viewer window. Calibration should be successful for a minimum of 
3 of 4 capillaries (or 12 of 16 capillaries, respectively). When using CS5 as 
a matrix standard, the calibration profile window shall reflect the following 
peak sequence (left to right) blue-green-yellow-red-orange. If calibration is 
successful, it is recommended that it be renamed with a more convenient 
name. To do this, press the Rename button, enter a new calibration name 
(e.g. CS5_[date] and press OK. Note that for each virtual filter set (dye set) 
the last calibration automatically becomes active. If you plan to use the 
results of previous calibrations, you should activate them before starting the 
instrument.  
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4.2. Capillary electrophoresis conditions 

Before performing the first Animaltype Sheep amplification product analysis 
on a genetic analyzer, you must create the corresponding Run Module. To 
do this, go to the Module Manager of the Data Collection Software and press 
the New button. The Run Module Editor window will be opened. Create the 
module by editing Injection Time and Run Time with the following 
parameters:  

Parameter Value 

Oven Temperature 60 

Poly Fill Volume 4840 

Current Stability   5 

PreRun Voltage       15 

PreRun Time     180 

Injection Voltage         3 

Injection Time         5 

Voltage Number of Steps      40 

Voltage Step Interval      15 

Data Delay Time         1 

Run Voltage 15 

Run Time 1300 

Press Save As and enter a convenient name for the created module (for 
example, Animaltype Sheep). Press OK and exit the module editor by 
pressing Close. 
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4.3.  Creating an Instrument Protocol  

Go to the Protocol Manager section of Data Collection Software. In the 
Instrument Protocol window, click the New button to open the Protocol 
Editor. It is necessary to enter the following parameters: 

Parameter Value 
Name e.g. Run36_Sheep 

Type REGULAR 

Run Module* Animaltype_Sheep 

Dye Set Any5Dye 

* for the value of the parameter, see item 4.2. 

Press the OK button to save the changes and exit the protocol editor. 

 

4.4. Preparation and loading of amplification products 

To load samples into the device it is necessary to prepare a mixture of Hi-
DiTM formamide and S550 size standard (diluted in accordance with 
paragraph 2.2) in the following ratio: 

Component  Volume per sample 
Hi-DiTM formamide 10.0 µl 

SizeStandard S550 1.0 µl 

When calculating the volume of the mixture components, note that all wells 
where injection will take place, including those without samples, should be 
filled with Hi-DiTM formamide mixture.  After stirring, add 10 µl of mixture to 
each well of the plate. Then add 1 µl of PCR product or allele ladder to the 
wells. If necessary, remove the bubbles from the bottom of the plate wells by 
short centrifugation. Cover the plate with a rubber mat and load it in 
accordance with the ABI PRISM® Genetic Analyzer user manual. The 
Animaltype Sheep kit does not require temperature denaturation of the 
samples! 
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4.5.  Starting the device 

Capillary electrophoresis on the ABI PRISM® genetic analyzer is performed 
according to the user's manual provided by the manufacturer. To obtain 
correct results, an appropriate Spectral calibration (see section 4.1), Run 
Module (see section 4.2), and Instrument Protocol (see section 4.3) must 
be performed. 

 

Step A Creating the plate 

Before starting the analysis, you should create a Plate that describes the 
location of the samples on the 96-well plate and provides instructions for the 
instrument. Go to the Plate Manager of the Data Collection Software and 
click the New button. The Plate Dialog box will appear. Enter the following 
parameters: 

Parameter Value 
Name For example: Animaltype_Sheep _[date] 

Application select GeneMapper 

Plate Type 96-Well 

Click OK. A new Plate Editor table will appear. 

 

Step B Fill the table 

Parameter Value 

Sample Name The sample name 

Priority is usually 100 (the order of analysis in 
ascending order) 

Sample Type 
Sample / Allelic Ladder / Positive Control / 
Neg. Control  
 

Size Standard S550 

Panel Animaltype_Sheep_Panels_Vx 

Analysis Method Animaltype_Sheep 

Bins Animaltype_Sheep_Bins_Vx 

Results Group Select the appropriate Results Group 

Instrument Protocol e.g. Run36_Sheep 
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For convenience, it is better to enter all sample names first. Then, for the first 
sample, set all the necessary parameters. Select all columns with the mouse 
cursor. In the Edit menu, select Fill Down. The program will fill in all selected 
cells with values. After these actions, edit the Sample Type column by 
selecting between Allelic Ladder / Positive Control / Negative Control values. 

 

Step C Start the device and information about the device status 

Go to the Run Schedule section and click the Find All button. Find the name 
of the created plate in the list, select it and link it with the image of the plate  
installed in the device. Start the plate analysis. 

Fluorescent sample profiles can be viewed in real time in the Capillaries 
Viewer or Cap/Array Viewer section. If system errors occur, information 
about them will appear in the Event Log (Error Status) section. 

 

4.6. Optimizing the intensity of signals 

To increase the intensity of peaks it is possible to increase the injection time 
up to 15 sec and/or increase the voltage up to 15 kV. This needs to be done 
by editing the Run Module (4.2.).  
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 Electrophoresis on ABI PRISM® 3500/3500XL Analyzer  

When working with the ABI PRISM® genetic analyzer, and subsequent 
analysis of fluorescent profiles in the GeneMapperTM program, it is necessary 
to follow the user instructions from the equipment manufacturer. For correct 
visualization of the five fluorescent Animaltype Sheep labels, it is necessary 
to perform spectral calibration for the "Any5Dye" dye set using CS5 matrix 
standard. 
 

5.1. Matrix creation/spectral calibration  

Analysis of Animaltype Sheep amplification products on the genetic analyzer 
is possible only after calibration with 5-color matrix-standard CS5 (not 
supplied with the kit, ordered separately by catalog number: 11-14102-
0050). The matrix standard contains a mixture of 5 fragments of different 
sizes marked with different fluorescent dyes. These dyes are used in the 
PCR tagging kit and the S550 size standard. To prepare a working solution 
of matrix standard CS5, add 50 µl of deionized water to a tube containing 
lyophilized CS5 (violet lid tube) and incubate at room temperature for 2 min. 
Then thoroughly mix the solution on the Vortex and collect the solution by 
short centrifugation at the bottom of the tube. The ready solution can be 
stored in a dark place at 2 °C – 8 °C for up to 2 weeks. For longer storage 
time, the solution should be frozen. Repeated defrosting should be avoided. 

 

Preparation of a matrix standard for calibration (ABI 3500 /8 capillaries)  

Hi-DiTM Formamide 80 µl 

Matrix Standard CS5 8 µl 

 

Add 10 µl of mixture to the A01-H01 wells of the 96-well plate. If necessary, 
remove bubbles from the bottom of the wells by centrifuging.  
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Preparation of the calibration standard matrix (ABI 3500XL/ 24 
capillary) 

Hi-DiTM Formamide 240 µl 

Matrix Standard CS5 24 µl 

 

Add 10 µl of mixture to wells A01 to H03 of 96-well plate. If necessary, 
remove bubbles from the bottom of the wells by centrifuging. 

 

Spectral calibration  

Step A - Create a Dye Set for spectral calibration  

Go to the Library section in Data Collection Software. In the Analyze 
section, select the Dye Sets tab. In the menu that opens, click Create (a new 
Dye Set creation dialog box will open). In the window that appears, specify 
the parameters of the new Dye Set:  

Dye Set Name CS5 

Chemistry Matrix standard 

Dye Set Template Any5Dye Template 

Arrange Dyes Parameters leave unchanged 

Matrix Condition Number 20.0 

Minimal Quality Score 0.8 

 

Press the Save button. The new Dye Set (CS5) will appear in the list. 

 

Step B - Perform spectral calibration  

Go to Maintenance section in Data Collection Software. In the Calibrate 
section, select the Spectral Calibration tab. In the window that opens, select 
the number of wells in the plate used and the plate's Plate Position. In 
Chemistry Standard select Matrix standard. In the Dye Set item select CS5. 
Start the calibration process by pressing the Start Run button.  
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Step C - Evaluation of Spectrum Calibration Results  

Check the status of each capillary (pass or fail) after the device is finished. 
The peak heights should be at least 500 rfu, but below 10,000 rfu (optimal 
range between 1,000 and 5,000 rfu). Calibration shall be successful for a 
minimum of 6 of 8 capillaries (or 18 of 24 capillaries, respectively). When 
using CS5 as a matrix standard, the calibration profile window (Intensity vs 
Pixel Number) should show the following peak sequence (left to right) blue-
green-yellow-red-orange. 

 
 

If calibration is successful, save the results by pressing the Accept button. 

 

5.2.  Create Instrument Protocol  

Go to the Library section in Data Collection Software. In the Analyze 
section, select the Instrument Protocols tab. In the menu that opens, click 
Create (a new Instrument Protocol creation dialog box will open). In the 
window that appears specify the parameters of the new Instrument Protocol:  

Application Type HID 

Dye Set CS5 

Run Module e.g. "HID36_POP4" (select the protocol 
corresponding to system parameters) 

Protocol Name Animaltype_Sheep 

 

Edit the Run conditions for Injection voltage to 3 s and adjust run time to 
analyze up to 550 bp. 

Press the Save button. 
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5.3. Create Assay  

Go to the Library section in Data Collection Software. In the Manage 
section, select the Assays tab. Click Create button in the menu that opens 
(a new Assay creation dialog box will open). In the window that appears 
specify the parameters of the new Assay:  

Assay Name Animaltype_Sheep 

Application Type HID 

Instrument Protocol Animaltype_Sheep 

 

Press the Save button. 

 

5.4. Preparation and loading of amplification products  

To load samples into the device it is necessary to prepare a mixture of 
Hi-DiTM formamide and S550 size standard (diluted in accordance with 
paragraph 2.2) in the following ratio:  

Component Volume per sample 
Hi-DiTM formamide 10.0 µl 

Size standard S550 1.0 µl 

When calculating the volume of the mixture components, note that all wells 
where injection will take place, including those without samples, should be 
filled with the mixture. After stirring, add 10 µl of mixture to each well of the 
plate. Then add 1 µl of PCR product to the wells. If necessary, remove the 
bubbles from the bottom of the plate wells by short centrifugation. Cover the 
plate with a rubber mat (septum) and load it in accordance with the ABI 
PRISM® Genetic Analyzer user manual. The Animaltype Sheep kit does not 
require temperature denaturation of the samples!  
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5.5. Starting the device  

Capillary electrophoresis on the ABI PRISM® Genetic Analyzer is performed 
according to the user's manual provided by the manufacturer. To obtain 
correct results, an appropriate Spectral calibration (see section 5.1), 
Instrument Protocol (see section 5.2), and Assay (see section 5.3) must 
be performed.  

 

Step A Creating the plate  

Before starting the analysis, you should create a Plate that describes the 
location of the samples on the 96-well plate and provides instructions for the 
instrument. To do this, go to the Create New Plate menu of Data Collection 
Software. A dialog box will appear in which you should specify the 
parameters of the new plate:  

Name For example, Animaltype_[date] 

Plate Type Fragment 

 

Press the OK button. A new table with the scheme of the examined plate will 
appear.  

 

Step B Filling the table 

For all the analyzed wells of the plate it is necessary to specify   

Sample name name of the object 

Sample type type of sample 

Assay Animaltype_Sheep (add from library - select 
Animaltype_Sheep) 

Filename convention file name structure (add from library - select 
My_FNC) 

Results group 
file saving options (folder where the results 
will be saved). -> add from library - select 
My_Fragment_Analysis_Result_Group) 

 

Left click to select all filled samples, then check the Assay, Filename 
convention and Results group options previously selected. 
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Step C Start the instrument and status information 

After creating the layout of the samples on the plate, click on the Link Plate 
for Run button. In the window that opens, specify the position of the plate in 
the device and start electrophoresis by clicking on the Start Run button. 

 

5.6. Optimizing the intensity of signals  

To increase the intensity of peaks, it is possible to increase the injection time 
up to 15 sec and/or increase the voltage up to 15 kV.  It is possible to intensify 
the signal by cleaning the PCR product from primers and salts. The amount 
of size standard in this case should also be reduced.  When working with 
highly sensitive ABI PRISM® 3500 Genetic Analyzers, undesirable effects 
may occur due to excessive signal fluorescence of amplified products at the 
stage of electrophoresis analysis. In this case, it is recommended to reduce 
the amount of genomic DNA material introduced into the reaction. In addition, 
reduction of excessive fluorescence signal level of amplified products can be 
achieved by reducing the time of injection of samples to 2-4 seconds in the 
Run Module. 
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 Data Analysis  

6.1. Import of files for analysis in GeneMapper program 

To analyze data in the GeneMapper™ program, you should import the 
necessary files with bins, panels, size standard and method of analysis 
according to the following instructions: 

1. Select menu item Tools->Panel Manager. 

 

2. In the upper left segment of an open window, place the cursor on the 
Panel Manager position. 
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3. In the menu select File -> Import panels. 

 

4. In the opened window, find and select a file with panels (e.g. 
Animaltype_Sheep_Panels_Vx). Load by pressing the Import button. 

5. After import of the Panel, select the Panel and import the related Bin 
Set by choosing Import Bin Set. Import Animaltype_Sheep_Bins_Vx.  

 
6. Select menu item Tools -> GeneMapper™ Manager. 
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7. In the window that opens, select the Size Standards tab. 

 

8. Press the Import button and select the S550 size standard file. Load the 
file by pressing the Import button. 

 

9. Go to the Analysis Method tab, press the Import button, select the file 
Animaltype_Sheep, upload the file by pressing the Import button. 
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10. When analyzing data in GeneMapper™, use the following parameters: 

Parameter  Value 
Analysis Method Animaltype_Sheep 

Panel Animaltype_Sheep_Panels_Vx 

Bins Animaltype_Sheep_Bins_Vx 

Size Standard S550 

 

6.2. Size Standard S550  

Below is an example of an electropherogram with S550 size standard 
fragment signals in an Orange detection channel. Designations of 26 DNA 
fragments are given according to their size: 60, 70, 80, 90, 100, 120, 140, 
160, 180, 200, 220, 230, 240, 260, 280, 300, 320, 340, 360, 380, 400, 420, 
440, 450, 500 and 550 bp.  

Figure 1: S550 size standard electropherogram. Size of fragments in bp. 
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6.3. Size ranges of microsatellite markers 

Locus Range of 
allele size 

Allele of 
Control 
DNA OM-1 

Allele of 
Control DNA 
OF-2 

               
Marking Color             
 

McM042 81-107 87/93 87/89 Blue 
INRA006 106-134 110/116 110/116 Blue 
McM527 158-182 166/178 174/178 Blue 
ETH152 184-200 186/192 186/186 Blue 
CSRD247 205-261 211/227 213/213 Blue 
OarFCB20 75-115 99/105 91/105 Green 
INRA172 126-172 154/160 160/160 Green 
INRA063 165-215 189/195 169/175 Green 
MAF065 115-139 127/127 121/131 Black 
MAF214 175-267 189/223 189/189 Black 
INRA005 123-155 127/129 147/151 Red 
INRA023 190-224 200/216 200/200 Red 
AMEL Х-Y XY XX Green 

Table 2: Range of allele size 

 

6.4. Amplification of Control DNA 

 
Figure 2: Control DNA OM-1. 1 µl of control DNA was injected into the 
reaction. 
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Figure 3: Control DNA OF-2. 1 µl of control DNA was injected into the 
reaction. 

 

6.5. Interpretation of results  

As a result of capillary electrophoresis on the ABI PRISM® Genetic Analyzer, 
the GeneMapper™ software generates a fluorescent profile reflecting the 
electrophoretic mobility of PCR products. Using the S550 size standard, the 
sizes of the amplification products are determined with an accuracy of < 1 bp. 
The GeneMapper™ software allows the determination of allelic variants for 
each marker. The obtained genotypes of different animals can be compared 
to confirm or exclude kinship. One or two allelic PCR-products can occur 
foreach STR marker corresponding to homogeneous and heterozygous 
condition of the locus, respectively. The difference in the size of alleles is 
usually a multiple of 2 bp that reflects differences in number of dinucleotide 
repetitions. For correct determination of the genotype, the nature of stutters 
must be taken into account. Stutters are artificial by-products of PCR 
amplification of microsatellite markers. For dinucleotide markers, which 
include all loci of the Animaltype Sheep set except AMEL, stutters of -2 bp 
size are typical in relation to the main product. The intensity of the stutter 
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signal can reach 50% of the allele product intensity. If the allele size differs 
by 2 bp, the stutter of the longer allele is superimposed on the shorter allele, 
significantly increasing its signal level (Figure 4 B). 

 

A   B   C 

 

 

 

 

 

 

 

Figure 4: 
A - Example of heterozygous genotype 104/114,  
B - Example of homozygote 121,  
C - Example of heterozygote 155/157 with stutter overlaying on allele 155. 
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 Trademarks and Disclaimers  

GeneAmp®, ABI PRISM®, GeneMapperTM, Hi-DiTM and POP-4TM are 
trademarks of Applied Biosystems division (Foster City, US-CA) of Thermo 
Fisher Scientific Ltd. Nanofor® is a trademark of Syntol (Moscow, RU). Other 
registered names, trademarks, etc. used in this document, even if not 
specifically marked as such, are not to be considered unprotected by law. 

 

The intended use of Animaltype Sheep is to differentiate individual animals 
of domestic sheeps. It can be used for kinship analysis, for quality assurance 
and biodiversity assessment in herd breeding or for traceability of animals 
and mutton. The test kit is for research use only (RUO). The manufacturer 
gives no warranty for any application which is regulated by law in the 
countries of end-users. Thus, the end-users assume sole responsibility for 
regulatory compliance of the genetical analysis and its application(s).
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